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Chapter 1. Getting Started 
Installation 

Backing up your files 

If you already have Easy-PC installed, please remember to back up all your libraries, Technology 
files and any other data files before proceeding with the installation of the new version. The installer 
should not overwrite any of your own named files, but it can re-install new copies of our standard 
data files so if you have changed any of those files it is important to back them up first. If you are 
uncertain, check the time/date stamp on the file but in any case, make a back-up. 

Of course, backing up your data is important not only for the upgrade but also at regular intervals 
during design. 

Installation from a download link 

If you have been provided with download link, use this to download the installation executable, 
named EasyPC.exe. Find it in your Downloads folder using Windows Explorer and double-click it. 
You’ll need to type (or copy/paste) the password provided to unpack this file. Once the unpack 
password has been successful, you will be allowed to continue with the installation. 

All other instructions should be followed until you click Finish to complete the installation. 

The installation is the same for new and existing users alike. Existing users with versions prior to this 
latest version can install the new software over an existing installation without deleting the old one 
first. 

Installation From CD 

Installation is via the autorun setup. Insert the CD-ROM into your CD-ROM drive and wait a short 
time. The CD-ROM will run up to speed and an Easy-PC Welcome screen will appear. If autorun has 
been disabled on your computer you must execute the 'setup.exe' program using the Start menu and 
Run command from the Windows task bar. 

With the installer running, once the Welcome screen is displayed, double-click on the Install Easy-
PC - Version 23.0 option, or click then press Run. Following the instructions on the screen, you 
should use the same Destination Folder for the Program Files as your existing Easy-PC program 
files. 

All other instructions should be followed until you click Finish to complete the installation. 

Note: CDs are no longer supplied by default. A download link would have been supplied unless 
otherwise requested. 

Installing over existing Easy-PC software 

If you already have an earlier version of Easy-PC installed on your system and you wish to install the 
new version into the same folder as the earlier one, please note that you will then end up with both 
versions listed in the Windows Control Panel list of installed applications.  

If you don’t want the earlier one to be listed in the Control Panel, you will need to un-install that 
version before you install the new one. If you install the new software into the same folder as the old 
version then try to un-install the old one, you will find that the new software will not run as the un-
install will have removed many or all of the program files. 

If you wish to install and use the new version without removing the old one, you will need to install 
the new version into a different folder. The two versions will then operate independently and either 
can be un-installed without preventing the other from running. 
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Data Files Location 

There is a step in the Setup installation wizard that asks you where you want to place data files (for 
example, Libraries, Technology files, etc). The default is always to use the common documents 
folder, “Users\Public\Documents\Easy-PC” on Windows 7, 8 or 10 (or the local language 
equivalents) if you are installing for All Users, or into your own Documents folder if installing for 
current user only. 

Running Easy-PC 23.0 
As with all Easy-PC programs, an icon will appear in the Number One Systems folder, or the Start 
pane if using Windows 10, you may also wish to create an Easy-PC Shortcut icon on your desktop. 

To start the program, double-click on the Easy-PC icon from the Number One Systems folder or the 
Start pane if using Windows 10. 
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Chapter 2. New Features in Easy-PC V23 
Introduction 

All features are categorised as being applicable to Schematic (SCM), PCB, or more general use 
(unmarked). 

No Connect Pins 

Some devices have pins that have no internal connection within the component and need to be 
identified so that they are not to be connected. For example, the ESD protection diode package from 
Texas Instruments has four such pins: 

 
To help ensure that these are not accidentally connected in your design, a pin in a Component can 
now be marked as No Connect. This status is applicable to both Schematic and PCB designs. 

This property is accessed via the Pin Assignments grid of the Component Editor. A new column On 
No Connect allows to toggle the No-Connect state of each pin. A display of Yes in this column 
indicates the pin cannot be connected to. 

 
To use this feature in your design, the No Connect status has to be applied to your component in the 
Component Editor first. It is then added to the design (using Add Component) or to an existing 
component in the design (using Update Component). 

Note, the No Connect status is associated with each package defined for a component, the same as 
Component Pin Names. Ensure that each package that requires it has the status applied. 

 



8   Easy-PC V23.0 Supplement 

No Connect and Update Component 

When using Update Component to bring in changes made to a component, for example the No 
Connect status, none of the other switches for Existing Component Values or Positions affect the 
NC status. 

No-Connect Pins in your Design 

If you attempt to start or end a connection or track, or use the Add To Net command, on a pin marked 
as No Connect, the application will display a warning dialog asking you whether you really want to 
connect that pin. 

 
This is not like a Spacing rule that is strictly enforced, it is there for your guidance, so you can still 
connect the pin if you really need to do so in a particular situation. Sometimes for example it could be 
preferable to tie NC pins to ground. 

No Connect Pin Rules and Checking 

Design Rule Checking in both Schematic and PCB editors have a new check for No Connect pins 
having nets assigned, to assist in applying this property retrospectively to existing designs by editing 
components and updating them in the design. 

In Schematic designs In PCB designs 

  
 

Translate to PCB and Integrity Check will also report warnings about No Connect pins in the 
Schematic that have nets assigned to them: 

Transfer from Schematic to PCB. 
------------------------------- 
Report Written:     Thursday, July 04, 2019 
Design Path:        C:\Designs\Route66\ 
Design Title:       Route66_02 
Created:            04/07/2019 04:03:53 PM 
Last Saved:          
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Editing Time:       10 min 
Units:              thou (precision 2) 
 
Warning: connected 'No Connect' pin 2 on D1 
End Of Report. 

No Connect Pins and Properties 

Once defined as NC in the Component, the Properties of a selected Component Pad will display a 
note on the dialog to show that the Pad is marked as No Connect: 

 

No Connect Pins and Display 

The Display dialog has a new colour setting in Settings and Highlights that allows you to easily 
visualise the No Connect Pins in your Schematic or PCB designs: 
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No Connect Pins and Reports 

The standard Reports option on the Output menu now has a No Connect report that shows No 
Connect pin connected to a net and ones that have this status but are not connected. 

 
The report prints two separate blocks of data for NC connected and NC not connected: 
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New Warnings Page in Preferences 

Within the Preferences dialog, there is now a Warning page.  

Some messages currently being displayed by the application as normal yes/no (or OK/Cancel) 
message boxes have been changed to use the warning dialog which includes the option for “don’t tell 
me again”. These include deleting fixed items, deleting the copper belonging to a pour area being 
deleted, and creating a new named style. It will only be populated if they have been switched off and 
may contain nothing in the list on a new installation. 

 

Select Mask 

The new Select Mask capability provides you with a quick and easy method of filtering the selection 
for only certain types of items when working in Select Mode. 

There are four new buttons on the Edit toolbar and corresponding entries on the View | Select Mask 
menu and on the shortcut menu in Select Mode. These provide a simple method of telling Select 
Mode whether to pick or ignore items based on four categories:  

 Components (component shapes and pads but not component names) 

 Routing (including Vias) in PCB and Connections in SCM 

 Shapes 

 Text 

The default state is to have all four options enabled, you can then toggle them off and on from the tool 
bar buttons or menu commands when you need to. 

Note: The Select Mask settings do not apply in modes other than Select Mode, as these modes 
already have a restricted set of selection settings appropriate to the particular mode or command. 
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Open Hyperlink 
On the Values page of the Component Editor, a new button Open Link will open the selected value 
item as a hyperlink for any value that has text that looks like a hyperlink or a path to a file. 

 
This option will recognise any value that starts with http, https, www., a drive name such as C: or a 
UNC path name such as \\server\path. If you select a value in the list whose text matches one of these 
patterns, then the Open Link button will become enabled. Clicking this button will pass the text 
string to the operating system to be opened in your web browser or relevant application directly from 
the dialog. 

This Open Link button is also available on the Values tab of Properties for a Component, again 
allowing you quick access to reference material such as component datasheets directly from the 
application: 
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Refresh symbol in Component Editor 
When you are editing a Component, you may find that you need to edit a Schematic or PCB symbol 
that is referenced by that Component. You can do this easily by right-clicking on the Symbol preview 
window and choosing Edit Symbol in Library. 

 
When you have made the necessary changes to the symbol, saving it back to the library will now 
cause the previews in the Component to be refreshed by automatically reloading the newly saved 
symbol from the library. You no longer have to close and re-open the Component to see the changes. 

Wizards for New Schematic and PCB Designs 

New Wizards are now available to assist you in creating new Schematic and PCB designs. These are 
accessed from the Wizards tab of the New dialog on the File menu: 
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New Schematic Wizard 

The Schematic Wizard helps you to produce consistent schematic drawings by providing you with 
access to a Technology file to used and your favourite drawing outlines: 

 
When you select Finish, you get the choice of writing the design to a given name and starting the 
design using that name (without saving it to file) or to write the design to file using a name that you 
specify and starting the new design. 

New PCB Wizard 

The PCB Wizard takes you through a series of steps that are intended to help you construct the 
underlying technology required for a particular PCB setup.  

You can choose which Technology file to use, the Units, the Layers and the Board Outline. 

Technology 

 
The Technology page allows you to choose a technology file to use. You can either use the default 
technology set then add to it during the New PCB creation process in this wizard, or use your chosen 
Technology file. You can also your design Units and Precision to use. 
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Layers 

 
The Layers page allows you to define the number of layers and associated layers for use in the 
design. If your chosen technology file on the previous page already has those defined, you can check 
the radio button to use the ones from the technology file. If you wish to craft them on this page, then 
make your selections. 

Board Outline 

 
The Board page enables you to define the board size or copy an existing board outline from another 
existing Easy-PC PCB design.  
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The Board Preview windows allows you to confirm the board outline chosen is the one required. 

Finish 

When you select Finish, you get the choice of writing the design to a given name and starting the 
design using that name (without saving it to file) or to write the design to file using a name that you 
specify and starting the new design. 

Configuration Files 
To help you manage the transfer of application settings between computers, and to assist with the 
backup of application settings in case of system failure, you can now save and load Configuration 
Files using the new tool that is accessed from the Configuration Files command on the Help | 
Support menu. 

When you select this command, a separate application is launched to do the work. This application 
will save the existing settings from the ‘current user’ section of your system Registry to a file, or load 
a previously saved Configuration file into the Registry.  

Management of Configuration files is done outside of the main application to ensure that the 
information in the Registry is fully up-to-date before a Configuration is saved, and that any 
information restored to the Registry is present for the Easy-PC application to load when it is next 
started up.  

You should therefore close your Easy-PC application once the Configuration Files tool has been 
launched. You can also launch the tool from the shortcut on the Start menu that is placed there when 
the software is installed. 

 
When run, you are presented with the Configuration Files dialog: 
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Configuration files contain a simple textual representation of the application settings. These are saved 
with the file extension .acf. We do not recommend that you attempt to edit these files; the application 
does not have any ‘special knowledge’ of the meaning of the various settings stored in the file, so 
alteration of the contents could lead to faulty application settings in the Registry which in turn could 
cause the main application to perform incorrectly or even be unstable. 

Save to Library Displays Information About Duplicates 

There is a new check box on the Save To Library dialog within the Library Manager allowing you 
to check for duplicates. This operates on all library types; Components, SCM Symbols and PCB 
Footprints: 

 
This will tell you if the library item you are about to save exists in any other currently enabled library, 
to help you avoid accidentally creating unwanted duplicate library items. You may still want to save 
the library item with that name, for example to create a custom copy of a symbol that is provided by 
the standard libraries so that your custom symbol is the one that is used when adding components to a 
design. 

If any duplicate items are found, the names of the libraries in which they are located are listed on a 
popup dialog. If any of the libraries are earlier in the search order than the library to which you are 
about to save your item then these are marked with an asterisk to highlight the fact that these would 
be used in preference to the one you are attempting to save. 

 
The same check is also available in the Save Items to Library and Import Items to Library dialogs 
available on right-click from design and drag-and-drop (or Add File) in Library Manager. As these 
dialogs handle multiple library items, those items that have duplicates will be marked but there won’t 
be a list of library file names as each component or symbol could be duplicated in different ways. 
However, this should still provide you with sufficient information to determine the possible effects of 
having those duplicate items present in your set of library files. 
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You can also alter this setting with the check box on the Preferences | General dialog: 

 

Add Component and Library Manager Dialogs Resizable 
For more flexibility in displaying long component and path names, the dialogs for Add Component 
and Libraries can now be resized. To resize the dialog, grab the corner or bottom or right-hand edge 
of the dialog using the cursor to resize it. 

Export Images as Bitmap and Metafile 
This feature gives us two new commands on File menu Export > to output image to Bitmap and 
image to Metafile. 

Add Text Choose Style and Alignment 

When adding new text items to a design or symbol, controls are now available on the Add Text 
dialog to allow you to choose the Text Style from the currently defined list of Text Styles in Design 
Technology, and to adjust the text Alignment, all before placing the text. Previously you could only 
alter these by separate commands either during placement of the text or in Properties after the text 
has been placed. Properties can still be used to change the Style and Alignment of course. 
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Add Track or Shape Off-grid 
When adding or editing a track or shape, holding the Ctrl key down will temporarily disable gridding, 
to allow you to place the next corner off the grid. 

This could be a useful feature if, for example, you want to snap a track into a fine pitched SMD pad 
but want the routing to stay on a fairly coarse grid: 

 
Note: We advise that you use the function sparingly to avoid shapes that are off-grid. 

Highlight Net Interactive Mode 

There is a new command on the View menu under Highlight Net named Interactive. This provides a 
special ‘mode’ of selection which highlights nets as items are selected.  

Whilst in this mode, you can click on any item in the design and if that item belongs to a net then the 
whole net will be highlighted (drawn in the Net Highlight colour). Select a different item and the 
first net is redrawn without highlight and the newly selected net is then highlighted. 

 
A special cursor confirms you are using this mode. 

On the context menu in this mode you can toggle Highlight without click which flips between 
normal select mode (pick as you click) and an “auto select” mode where it will continuously attempt 
to pick items as you move the cursor, providing you with instant feedback on the connectivity in your 
design. 

 
From the context menu, you can also Cancel this mode and use the menu to Remove Highlight. 
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Make Cutouts from Shapes 
The new command, Make Cutouts, appears on the shortcut menu in Select Mode when you have 
two or more closed shapes of the same type (and on the same Layer in a PCB or footprint) selected. 

  
The selected shape with the largest area is used as the ‘parent’ shape, and all the other selected closed 
shapes that overlap with this parent shape are used to make cutouts of the outer shape. The original 
‘inner’ shapes are then deleted. 

 
Choosing Make Cutouts on the context menu, produces this below. The smaller shape has been ‘cut’ 
from the larger shape. 

 
Another example of this would be to use the second shape to add cutout detail to the parent shape: 
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Selecting both shapes will cut the smaller shape from the larger one, evident once the shape is filled: 

 
Confirmation that a shape is a cutout can be seen on the Status bar with the cutout shape selected: 

 
This command can be useful for example if you have imported DXF data to create a company logo 
but it is only defined as a set of nested shapes without any information about cutouts or filling.  

For example, you can take this set of five separate shapes (two nested inside larger shapes) as might 
be the case for text shapes: 

 
Using this command, quickly turn it into these three filled shapes: 

 

Group Name Shown On Status Bar 

The Status bar will now show the name of the Group to which the selected item belongs: 
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There is also a setting on the Preferences | Display dialog to include the Group name on Design 
Tooltips: 

 
When viewed in the design, with one or more items within the group selected, the tooltip will appear 
like this: 

 

Display Grid in Previews 

There is a new check box in Preferences | Display, called Screen Grid from Tech File in Previews.  

With this selected it allows you to override the normal behaviour of suppressing any visible screen 
grid in symbol previews. If you check the box, any visible grid in the current technology file of the 
relevant type will be drawn in the preview.  

In summary, checked will suppress the screen grids in symbol previews. not checked will draw the 
grids. 
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With the check box checked: 

 
The grid dots are quite subtle, this is what a zoomed in view looks like: 

 
With the check box unchecked grid dots are always forced off: 
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Cross Probe Single-shot Operation 
A new check box on the Preferences dialog and Cross Probe page has been added. This new feature 
enables Single-shot Operation. This will tell the Cross Probe mode to probe once and then return to 
Select Mode. If this box is unchecked, then you will stay in Cross Probe until you cancel out or select 
some other mode. 

 

BOM Composer turn off Auto-generate Report 
The normal operation of BOM Composer is to generate the report with every alteration you make to 
the report template or settings so that you can quickly adjust the operation. 

 
With the BOM options unfolded, the new Auto Save check box allows you to override this 
behaviour, and only generate the report when you check the new Save button. The on-screen report 
will still be updated as you make changes to settings or the report template, but the files needed to 
update the on-screen display are generated in a temporary folder so that they do not affect your own 
project data. 
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Plotting Auto-load Job File 
On the Plotting and Printing dialog and Options, there is a new check box Auto load Job File. 
With this checked, opening the Plotting dialog will automatically load a job file from the same 
location as the design. For a PCB design or a SCM that is not in a project, it will look for 
<designname>.EPJ, for a SCM in a project it will look for <projectname>.EPJ. 

 

Display Net Name on Component Select (SCM) 
You can now select a whole component and show/hide net names for all connected pins/pads on that 
component in one go. Previously you could only do this for a single pad.  

When you have multiple items selected and this includes one or more components, the Display Net 
Name command will show the net name for all connected pins on those components. 

 

You can also switch off all net names 
associated with the component by selecting it 
and unchecking Display Net Names form the 
context menu. 
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Move Net Name Highlights Net (SCM) 

In a Schematic design, when you move a net name you now have the option to automatically 
highlight the entire net to which that net name belongs. 

This option is controlled by a new check box in the Preferences dialog under Schematics 
Interaction called Highlight Net on Move Net Name. 

 

Unfinished Connection Report (SCM) 

Available from the Output menu, Reports, the Unfinished Connections report will show you any 
connection that doesn’t end on either an electrical pin or doesn’t connect to another point using an 
implied net name 

Height Check Areas Renamed to Component Areas (PCB) 
Height Check Areas have been renamed to Component Areas to reflect a wider range of their use, 
such as for use with Component Rules (see below) as well as their height checking capabilities. 

Component Areas 

When editing the Properties of a Component Area, you can assign it a name but with no height 
value. If you add a Height value, it can be used for multiple uses. 

 
This can then be used within the Component Rules and Auto-Place feature. 

Component Rules (PCB) 
Component Rules allow you manage your component placement using simple keep in/out rules that 
use wildcard matching of Component Properties to areas. (Height Check areas have been renamed 
to Component Areas to reflect this additional use). 
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Component Rules are set up on the new Comp Rules page on the Design Technology dialog.  

 
Each rule uses a wildcard string to match the desired components by value, reference name, 
component name, group or sheet name or within a named area. 

 
When moving a single component, areas which are relevant to the rules for that component are drawn 
highlighted in two colours: in the normal Highlight colour for Keep In areas, and in the Clearance 
Error colour for Keep Out areas where that component should not be placed. This includes 
highlighting as ‘keep out’ any areas which specify a height restriction lower than the height of the 
component being placed. These visual cues provide you with instant feedback to assist with your 
component placement. 

 
 

With the Online DRC option enabled, you also get an instant warning 
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Overriding this DRC violation will write a DRC Error Marker, Properties of this marker will show 
you the error: 

 

Auto-place Using Rules (PCB) 
As well as the Component Rules assisting with manual placement, the Auto-place dialog has a new 
option to make use of these rules when placing components. 

 

Add Track Action on Cancel (PCB) 
There is a new check box in Preferences, PCB Tracks, for Cancel in Add Track returns to Select 
Mode. The default setting is True (to follow existing behaviour). 
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If this box is checked, then pressing Escape or cancelling while adding a track will cancel the mode 
and return to Select Mode. If instead this box is not checked, cancelling the current track will stay in 
Add Track mode waiting for you to start the next track. 

Edit Package in Library (PCB) 

If you right-click on a component, you can now select a new command Edit Package In Library. 
This will open the 3D package edit dialog showing the 3D package that corresponds to the 
component’s footprint. 

 

Enhanced Functionality for Create Fanout Pattern (PCB) 
The Create Fanout Pattern dialog on the Tools menu, Auto Fanout > dialog has been enhanced. It 
now has controls to define how to automatically calculate the offsets so that vias are placed midway 
between rows/columns of pads (previously the values were calculated based on the extents of pad and 
via). 

 

You can also choose the Via Layer Span from the drop-down list of spans to be used for the vias 
(previously always inserted them using Through-Hole span). 

 

Online Design Rule Check for Components (PCB) 
When using the Online DRC, the functionality has been enhanced to include Component Area and 
Component Height checks when placing a component. This ensures any rules set up through the 
Component Rules dialog or Component Height Properties will be checked dynamically.  
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Delete Unused Net Match (PCB) 

To assist in ‘trimming down’ a set of Net Match rules defined in a technology file to retain only 
those that apply in the current design, a new button, Delete Unused, is now available on the Spacings 
page of the Design Technology dialog. 

When you click this button, all the currently defined Net Match rules will be checked against the nets 
and net classes defined in the design, and any rules that do not match with anything will be deleted. 
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Add to Net on Pour Area (PCB) 
When you right-click on a Copper Pour Area that is not yet assigned to a net, choosing the Add To 
Net command will take you to a new dialog where you can use ‘filter’ options to help you quickly 
find the correct net for your Area. 

 
The list will contain net names inherited from the design where the area overlaps items on those nets. 
If the area does not cross anything, it will have no net names. In this instance you can type the net 
name required to add it to that net, or type a new net name to create a new net for this area. 

Pour Copper adds DRC Error Markers (PCB) 
When using the Pour option, if it finds any issues it needs to tell you about (e.g. insufficient thermal 
spokes, copper area too small or unconnected) these are already listed in the report, but it will now 
also add DRC error markers (code “Cu”) to the design so that you can find them using the Goto 
bar. 

 
When you re-pour or clear any copper area, any copper DRC markers within that area and on the 
same layer as the area are removed. 
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Rename Component “immediate” mode (PCB) 
The existing point and click interactive Rename Components mode on the Tools menu has been 
extended to allow a simple “immediate” rename of all components matching the supplied name stem.  

 
On use, the option returns to the Rename Components dialog ready for the next action. 

Also, there are additional radio buttons on the dialog. 

Apply Name Stem To All 
When using this mode (which is only available if the two component name stems are different) then 
the rename action will take place as soon as you click the OK button.  

A message will be displayed showing how many components were renamed, and you will be able to 
choose whether to return to the dialog to rename some more components, or exit from the rename 
operation.  

Interactive Rename 
When using the Interactive Rename you need to enter the start number from which the 'new' 
component names should begin.  

When you click OK, the dialog closes and the 'point and click' renaming can begin. All the 
components matching the chosen stem will be highlighted to help you see them easily on your design.  

Each time you select a component, the current name in the sequence is assigned to that component, 
and the sequence number is incremented. The next name to be applied is always displayed on the 
Status Bar.  

If the next name to be applied is already in use elsewhere in the design, the application will ensure 
that the names are swapped over so that no duplicate names exist. 

Swap Components (PCB) 

The ability to swap two components to exchange their positions has been added. 

Select the option from the Edit menu and Swap Component Positions, select the first component 
and then the component to swap with. 

You can also select the two components first, then choose the option from the Edit menu. 

This option will swap similar components and components that are unlike, provided they can be 
swapped, for example if it creates a DRC error because of a Component Rules area violation. 
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Intelligent Gerber Import Improvements (PCB) 
Drag and Drop 

You can now take Gerber or Excellon or BOM files and drag them from your desktop or Windows 
Explorer window and drop them onto the Intelligent Gerber Import dialog. This will operate the same 
as if you had used the Add button on the dialog but is obviously much quicker. 

New Dialog Navigation 

 
There is a new Clear button to empty the list of input files. 

There are new Load and Save buttons to load and save settings files that define a set of files to 
import. 

There is a new check box option to Auto Save (and auto load) the dialog settings so that the next time 
the dialog is opened, it returns with same files as before. 

More File Information 

There is more information about file contents displayed on the dialog. For example, the file Units and 
Gerber format. 

 
Better Layer Name Matching 

The Intelligent Gerber Import dialog now does a much better attempt at name matching of Gerber 
files when matching the filename to Layers in the design, such as Silkscreen, Solder Resist, etc. 


